
Σε πολλά ακαδημαϊκά μαθήματα η παροχή σημειώσεων και διαφανειών είναι τα κύρια οχήματα υποβοήθησης 
της μελέτης των φοιτητών. Εάν το υλικό αυτό δεν είναι κατάλληλα σχεδιασμένο, τότε απευθύνεται μόνο σε 
ένα μέρος του φοιτητικού κοινού και δεν καλύπτει τις ανάγκες των εντυποανάπηρων φοιτητών. 

Οι κυριότερες εφαρμογές γραφείου διαθέτουν λειτουργικότητές που αυξάνουν την προσβασιμότητα των εγ-
γράφων και σε συνδυασμό με απλές και εύκολες πρακτικές που μπορείτε να ακολουθήσετε κατά τη σύνταξη 
του υλικού σας, θα το καταστήσουν προσβάσιμο σε όλους. Παρακάτω θα βρείτε κάποιες βέλτιστες πρακτικές 
για τη δημιουργία προσβάσιμων κειμένων και παρουσιάσεων.  

 

 

Συμβουλή: Μπορείτε να χρησιμοποιήσετε τον έλεγχο προσβασιμότητας 
στον κειμενογράφο που χρησιμοποιείτε  για να βεβαιωθείτε ότι το περιε-
χόμενό σας είναι πραγματικά προσβάσιμο. Ο έλεγχος προσβασιμότη-
τας εντοπίζει τυχόν προβλήματα στο έγγραφό σας και εξηγεί γιατί το κα-
θένα μπορεί να αποτελέσει πιθανό πρόβλημα για κάποιον με ειδικές ανά-
γκες. Επίσης, παρέχει υποδείξεις σχετικά με τον τρόπο επίλυσης κάθε ζη-
τήματος. 

Μπορείτε να βρείτε τον ελεγκτή προσβασιμότητας στην καρτέλα Review (Αναθεώρηση). Αν δεν τον βλέπε-
τε, τότε μεταβείτε στο File > Info (Αρχείο > Πληροφορίες) και επιλέξτε Check for Issues (Έλεγχος για θέμα-
τα). 

 

 

 

Οι οδηγίες αφορούν το Office 365 και το Acrobat Pro. Κάποια στοιχεία πιθανόν να εμφανίζονται διαφορετικά σε άλλες 
εκδόσεις των προγραμμάτων αυτών ή σε άλλα αντίστοιχα λογισμικά, το σκεπτικό όμως παραμένει το ίδιο. Για περισ-
σότερους πόρους και πληροφορίες, καθώς και αναλυτικά παραδείγματα μπορείτε να ανατρέξετε στην επίσημη σελίδα 
του Office https://bit.ly/3ePbIrw και του Adobe Acrobat https://adobe.ly/2OO9JcI. 

 

 

 

https://support.microsoft.com/el-gr/office/βελτίωση-προσβασιμότητας-με-τον-έλεγχο-προσβασιμότητας-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f#picktab=windows
https://support.microsoft.com/el-gr/office/κανόνες-για-τον-έλεγχο-προσβασιμότητας-651e08f2-0fc3-4e10-aaca-74b4a67101c1


 

 

Μια από τις πλέον αποτελεσματικές πρακτικές για να καταστεί προσβάσιμο ένα κείμενο σημειώσεων είναι η 
επιμέλεια της δομής του και η δυνατότητα περιήγησης σε αυτό. Η δομή και η σήμανσή της επιτρέπουν στις 
υποστηρικτικές τεχνολογίες, όπως για παράδειγμα σε συνθέτες φωνής, να αναπτύξουν ομαλά και εύκολα τα 
νοήματα του κειμένου και παράλληλα να επιτρέψουν στον χρήστη να περιηγηθεί στις ενότητές του. 

Επίσης, ένα σωστά δομημένο έγγραφο μπορεί εύκολα να μετατραπεί σε μια μορφή που προτιμά ο χρήστης 
και να αναπαραχθεί σωστά από τις προτιμώμενες υποστηρικτικές τεχνολογίες, π.χ. μπορεί να διαβαστεί από 
έναν συνθέτη φωνής και να παρέχει τη δυνατότητα περιήγησης μέσω προγραμμάτων ανάγνωσης οθόνης ή 
άλλων βοηθητικών τεχνολογιών, διατηρώντας τη λογική σειρά που εμπεριέχει το κείμενο. 

 

 
1. Χρησιμοποιήστε όσο το δυνατόν πιο απλή γλώσσα που να είναι κατάλληλη για το έγγραφό σας. 

2. Επιλέξτε την κατάλληλη γραμματοσειρά. Το μέγεθος γραμματοσειράς θα πρέπει να είναι τουλάχιστον 12 
στιγμές. 

3. Αν και η αλλαγή γραμματοσειρών είναι μια εύκολη πλέον διαδικασία προτιμήστε να  χρησιμοποιήστε μια 
γραμματοσειρά δίχως ακρέμονες (sans-serif), όπως Arial, Helvetica, Verdana, Tahoma και Trebuchet MS, οι 
οποίες είναι ειδικά σχεδιασμένες για ανάγνωση σε οθόνη. 

4. Επιλέξτε αριστερή στοίχιση, αντί για μπλοκ κειμένου (πλήρης στοίχιση). 

5. Συμπεριλάβετε εναλλακτικό κείμενο (alt text) σε όλα τα γραφικά στοιχεία, όπως εικόνες, γραφήματα, κλπ. 
Στο οπτικό περιεχόμενο περιλαμβάνονται οι εικόνες, τα γραφικά SmartArt, τα σχήματα, οι ομάδες, τα 
γραφήματα, τα ενσωματωμένα αντικείμενα, και τα βίντεο. Η σύντομη αυτή περιγραφή βοηθά τους χρή-
στες που δεν μπορούν να τα δουν στην οθόνη να κατανοήσουν τι περίπου απεικονίζει. Μπορείτε να προ-
σθέσετε εναλλακτικό κείμενο κάνοντάς δεξί κλικ επάνω στην εικόνα και επιλέγοντας το Edit Αlt Τext 
(επεξεργασία εναλλακτικού κειμένου). Αν δεν υπάρχει ως επιλογή, τότε από το Picture Format 
(Μορφοποίηση εικόνας) μπορείτε να βρείτε την καρτέλα Layout and properties (Διάταξη και ιδιότη-
τες) και να  προσθέσετε εκεί στο Alt Text (Εναλλακτικό κείμενο) την περιγραφή της εικόνας σας. Μία 
με δύο προτάσεις είναι αρκετές. 

6. Η λύση του εναλλακτικού κειμένου προσφέρεται και για την προσβασιμότητα εξισώσεων, 
π.χ. στον ορισμό της εικόνας θα μπορούσε να προστεθεί το κείμενο «Ως μέση ταχύτητα (v) 
ενός σώματος ορίζεται το πηλίκο της απόστασης (d) που διανύθηκε προς το χρονικό διάστημα (t) 
που απαιτήθηκε». 

7. Αποφύγετε τη χρήση κειμένου στις εικόνες ως μόνης μεθόδου μεταφοράς σημαντικών πληροφοριών. Εάν 
πρέπει να χρησιμοποιήσετε μια εικόνα με κείμενο σε αυτή, επαναλάβετε αυτό το κείμενο στο έγγραφο. 
Στο εναλλακτικό κείμενο, περιγράψτε με συντομία την εικόνα και αναφέρετε την ύπαρξη του κειμένου και 
του σκοπού του. 

8. Προσθέστε ένα χαρακτηριστικό κείμενο υπερσύνδεσμου 
και συμβουλές οθόνης (Screen tips). Τα άτομα που χρη-
σιμοποιούν προγράμματα ανάγνωσης οθόνης ορισμέ-
νες φορές σαρώνουν μια λίστα υπερσυνδέσμων, οι ο-
ποίοι θα πρέπει να μεταφέρουν σαφείς και ακριβείς 
πληροφορίες σχετικά με τον προορισμό τους. Για παρά-
δειγμα, αντί για έναν σύνδεσμο με το κείμενο «Κάντε 
κλικ εδώ», συμπεριλάβετε τον πλήρη τίτλο της ιστοσελί-
δας προορισμού. Προσθέστε μια συμβουλή οθόνης, α-
ντίστοιχο του εναλλακτικού κειμένου για τις εικόνες, 
ώστε να περιγράφεται τι είναι η ιστοσελίδα στην οποία 
παραπέμπετε.  

9. Περιορίστε την χρωματική κωδικοποίηση και βεβαιωθείτε ότι το χρώμα δεν είναι ο μόνος τρόπος μετα-
φοράς πληροφοριών. Τα άτομα που έχουν προβλήματα όρασης ή αχρωματοψία ενδέχεται να μην κατα-
νοούν τη σημασία ορισμένων χρωμάτων. 

10. Χρησιμοποιήστε επαρκή αντίθεση για τα χρώματα κειμένου και υποβάθρου (φόντου). Εάν το έγγραφό 
σας έχει υψηλή αντίθεση, τότε περισσότερα άτομα μπορούν να δουν και να χρησιμοποιήσουν το περιε-
χόμενο του. Για τα κείμενα, η αντίθεση μαύρων χαρακτήρων και άσπρου υποβάθρου είναι πολύ ικανο-
ποιητική. 

11. Χρησιμοποιήστε τις ενσωματωμένες κεφαλίδες και στυλ. Για να διατηρήσετε τη δυνατότητα πλοήγησης 
με  tabs και να διευκολύνετε την ανάγνωση των εγγράφων σας από τα προγράμματα ανάγνωσης οθόνης, 
χρησιμοποιήστε μια λογική σειρά επικεφαλίδων και τα ενσωματωμένα εργαλεία μορφοποίησης του 
Word. Για παράδειγμα, οργανώστε τις επικεφαλίδες με την προκαθορισμένη λογική σειρά. Χρησιμοποιή-
στε πρώτα το στυλ Επικεφαλίδα 1, κατόπιν το στυλ Επικεφαλίδα 2 και μετά το στυλ Επικεφαλίδα 3 και όχι 



ανακατεμένα. Επίσης, οργανώστε τις πληροφορίες που περιέχουν τα έγγραφά σας σε μικρά τμήματα. Ιδα-
νικά, κάθε επικεφαλίδα θα πρέπει να περιλαμβάνει λίγες μόνο παραγράφους. Χρησιμοποιείτε κεφαλίδες 
μόνον όπου θέλετε να επισημάνετε τη δομή, και όχι για να διακοσμήσετε το περιεχόμενο. 

12. Χρησιμοποιήστε μια απλή και αρμονική δομή για τους πίνακες. Καθο-
ρίστε επίσης πληροφορίες κεφαλίδας για κάθε στήλη. Από την καρτέ-
λα Table Design (Εργαλεία πίνακα), η οποία εμφανίζεται όταν επιλέ-
γουμε τον πίνακα, και το Format (Σχεδίαση), επιλέγουμε Header 
Row (Γραμμή Κεφαλίδας). Τα προγράμματα ανάγνωσης οθόνης χρη-
σιμοποιούν επίσης τις πληροφορίες κεφαλίδας για να αναγνωρίζουν 
τις γραμμές και τις στήλες. Εάν ένας πίνακας είναι ενσωματωμένος σε 
έναν άλλο πίνακα ή εάν ένα κελί είναι συγχωνευμένο ή διαιρεμένο, το 
πρόγραμμα ανάγνωσης οθόνης χάνει το μέτρημα και δεν μπορεί να 
παρέχει χρήσιμες πληροφορίες μετά από αυτό το σημείο. Τα κενά κε-
λιά σε έναν πίνακα θα μπορούσαν επίσης να παραπλανήσουν κάποιον 
που χρησιμοποιεί ένα πρόγραμμα ανάγνωσης οθόνης να νομίσει πως 
δεν υπάρχει κάτι άλλο στον πίνακα. Τέλος, κάθε πίνακας χρειάζεται 
ένα εναλλακτικό κείμενο, όπως οι εικόνες. Για να προσθέσουμε εναλλακτικό κείμενο σε έναν πίνακα τον 
επιλέγουμε και εν συνεχεία από τη διαδρομή Table Properties (ιδιότητες Πίνακα) > Alt Text 
(Εναλλακτικό κείμενο) καταλήγουμε στο πλαίσιο εισαγωγής του εναλλακτικού κειμένου. 

 

 

 

Συνηθίζεται οι παρουσιάσεις του PowerPoint να έχουν πολλά οπτικά στοιχεία. Τα άτομα με προβλήματα 
όρασης θα μπορούσαν να τις κατανοήσουν πιο εύκολα εάν δημιουργούσατε τις διαφάνειές σας λαμβάνοντας 
υπόψη την προσβασιμότητα. 

 

 
1. Χρησιμοποιήστε μεγαλύτερο μέγεθος γραμματοσειράς (18 στιγμών ή μεγαλύτερο), γραμματοσειρές sans 

serif (σημείο 3 προηγούμενης ενότητας) και επαρκή διαστήματα. Αποφύγετε τη χρήση κειμένου με όλα τα 
γράμματα κεφαλαία και την υπερβολική χρήση πλάγιας γραφής ή υπογραμμίσεων. Αφήστε επαρκή κενό 
χώρο μεταξύ των προτάσεων και των παραγράφων. 

2. Συμπεριλάβετε εναλλακτικό κείμενο σε όλα τα οπτικά στοιχεία, όπως περιγράφεται στο σημείο 5 της 
προηγούμενης ενότητας. 

3. Βεβαιωθείτε ότι το περιεχόμενο των διαφανειών μπορεί να διαβαστεί με τη σειρά που θέλετε. Ένα άτομο 
με φυσιολογική όραση διαβάζει τα μέρη μιας διαφάνειας με τη σειρά που αυτά εμφανίζονται. Αντίθετα, 
ένα πρόγραμμα ανάγνωσης οθόνης, διαβάζει τα μέρη μιας διαφάνειας με τη σειρά που έχουν προστεθεί, 
η οποία μπορεί να είναι πολύ διαφορετική από τη σειρά με την οποία εμφανίζονται. Για να βεβαιωθείτε 
ότι όλοι οι χρήστες διαβάζουν το περιεχόμενο με τη σειρά που θέλετε, είναι σημαντικό να ελέγξετε τη 
διάταξη ανάγνωσης. 

4. Όταν δημιουργείτε μια νέα διαφάνεια, χρησιμοποιήστε τις ενσωματωμένες σχεδιάσεις διαφανειών. Το 
PowerPoint περιέχει ενσωματωμένες διατάξεις που μπορείτε να εφαρμόσετε σε οποιαδήποτε διαφάνεια. 
Όταν χρησιμοποιείτε κάποια διάταξη σε μια νέα διαφάνεια, αυτή εξασφαλίζει αυτόματα ότι η σειρά ανά-
γνωσης λειτουργεί για όλους τους χρήστες. 

5. Προσθέστε χαρακτηριστικό κείμενο υπερσύνδεσης και συμβουλές οθόνης, όπως αναφέρεται στο σημείο 
7 της προηγούμενης ενότητας. 

6. Βεβαιωθείτε ότι το χρώμα δεν είναι ο μόνος τρόπος μεταφοράς πληροφοριών. Τα άτομα που έχουν προ-
βλήματα όρασης ή αχρωματοψία ενδέχεται να μην κατανοούν τη σημασία ορισμένων χρωμάτων. Για πα-
ράδειγμα, προσθέστε υπογράμμιση στο κείμενο υπερσύνδεσης με χρωματική κωδικοποίηση, έτσι ώστε τα 
άτομα με αχρωματοψία να γνωρίζουν ότι το κείμενο αποτελεί σύνδεσμο ακόμα και αν δεν μπορούν να 
δουν το χρώμα. Για τις επικεφαλίδες, εξετάστε το ενδεχόμενο να προσθέσετε έντονη γραφή ή να χρησιμο-
ποιήσετε μεγαλύτερη γραμματοσειρά. 

7. Χρησιμοποιήστε επαρκή αντίθεση για τα χρώματα κειμένου και υποβάθρου (φόντου). Οι συνδυασμοί με-
γάλης αντίθεσης διευκολύνουν επίσης τα άτομα με αχρωματοψία να διακρίνουν το κείμενο και τα σχήμα-
τα. Μπορείτε να χρησιμοποιήσετε τη δωρεάν εφαρμογή Colour Contrast Analyzer για τον έλεγχο της 
αντίθεσης των χρωμάτων που θέλετε να χρησιμοποιήσετε. Χρησιμοποιείτε συμπαγή χρώματα φόντου και 
όχι με διαβάθμιση (gradient). 

8. Δώστε σε κάθε διαφάνεια έναν μοναδικό τίτλο. Τα άτομα με προβλήματα όρασης ή ανάγνωσης βασίζο-
νται στους τίτλους των διαφανειών για την περιήγησή τους. Για παράδειγμα, με μια γρήγορη ανάγνωση ή 
με τη χρήση ενός προγράμματος ανάγνωσης οθόνης, μπορούν να σαρώσουν γρήγορα τη λίστα με τους 
τίτλους των διαφανειών και να μεταβούν απευθείας σε αυτή που επιθυμούν. 

https://developer.paciellogroup.com/resources/contrastanalyser/


9. Χρησιμοποιήσετε μια απλή δομή για τους πίνακες και καθορίστε πληροφορίες κεφαλίδας στήλης, όπως 
αναφέρθηκε στο σημείο 11 της προηγούμενης ενότητας. 

10. Καταστήστε τα ενσωματωμένα βίντεο στις διαφάνειες  προσβάσιμα για χρήστες με προβλήματα όρασης 
και ακοής. Εάν μπορείτε, χρησιμοποιήστε βίντεο με υποτίτλους, οι οποίοι είναι μια μεταγραφή (ή/και με-
τάφραση) του διαλόγου, ενώ οι κλειστές λεζάντες περιγράφουν τους διάφορους ήχους, όπως μουσική ή 
ηχητικά εφέ που ακούγονται εκτός διαλόγων.  

 

 

 

Πολλές φορές τα αρχεία κειμένου ή/και διαφανειών μετατρέπονται σε pdf, τα οποία και αυτά με τη σειρά τους 
μπορούν να είναι προσβάσιμα. Ένας τυπικός έλεγχος είναι η δυνατότητα αντιγραφής κειμένου. Αν από ένα 
αρχείο pdf δεν μπορεί να επιλεγεί κείμενο, τότε το πιθανότερο είναι πως παραμένει ένα αρχείο εικόνας, έστω 
και αν απεικονίζει κείμενο, και πως πρέπει να μετατραπεί (μετεγγραφεί) σε ψηφιακό κείμενο.  

1. Καθορίστε τη γλώσσα του εγγράφου σας. Αναφέ-
ρετε την κύρια γλώσσα σύνταξης του εγγράφου 
σας στα μεταδεδομένα του εγγράφου. Έτσι θα 
βοηθήσετε τους χρήστες να βρίσκουν τις πληρο-
φορίες κάνοντας αναζητήσεις στο Διαδίκτυο.  Ε-
πιλέξτε File > Properties > Advanced και συ-
μπληρώστε το Language Field. 

2. Από τη διαδρομή File > Properties μπορείτε  να 
προσθέσετε και τα υπόλοιπα αναγκαία πεδία 
όπως τον τίτλο, τον συγγραφέα και τις λέξεις 
κλειδιά. Οι ελάχιστες πληροφορίες που πρέπει να 
περιλαμβάνονται είναι ο τίτλος και η κύρια φυσι-
κή γλώσσα του εγγράφου.  

3. Στο Adobe Acrobat Pro μπορείτε να χρησιμοποιήστε τον έλεγχο προσβασιμότη-
τας από τη διαδρομή Tools > Accessibility > Full Check, ώστε να δείτε αν το 
έγγραφο σας είναι προσβάσιμο. Το σύνολο εργαλείων Action Wizard εμφανίζε-
ται στη δευτερεύουσα γραμμή εργαλείων. 

4. Χρησιμοποιήστε τις πιο ενημερωμένες εκδόσεις του λογισμικού που χρησιμο-
ποιείτε  για να δημιουργήσετε έγγραφα σε pdf μορφή. Οι νεότερες εκδόσεις λο-
γισμικού περιλαμβάνουν πιο προηγμένες λειτουργίες προσβασιμότητας. Ωστό-
σο, θα πρέπει να βεβαιωθείτε ότι το ηλεκτρονικό σας έγγραφο μπορεί να χρησι-
μοποιηθεί και από παλαιότερες εκδόσεις. 

Για περισσότερο αναλυτικές οδηγίες μπορείτε να ανατρέξετε στον επίσημο οδηγό 
του Acrobat Pro στον σύνδεσμο https://adobe.ly/2E67lvN. 

 

A  

Για να κάνετε πιο ανοικτό το υλικό σας, μπορείτε να προσθέσετε μια άδεια Creative Commons με την οποία 
κάποιος άλλος μπορεί να το επαναχρησιμοποιήσει, π.χ. ένας εντυποανάπηρος φοιτητής από κάποιο άλλο Πα-
νεπιστήμιο. Σε κάθε περίπτωση τα πνευματικά σας δικαιώματα είναι κατοχυρωμένα. Για μεγαλύτερη ασφά-
λεια μπορείτε να χρησιμοποιήσετε τις παρακάτω άδειες: 

by-nc: Αναφορά - Μη Εμπορική Χρήση 

by-nc-sa: Αναφορά - Μη Εμπορική Χρήση - Παρόμοια διανομή 

Για περισσότερες πληροφορίες σχετικά με την διαχείριση των πνευματικών δικαιωμάτων μπορείτε να επισκε-
φτείτε την σελίδα της Βιβλιοθήκης και Κέντρου Πληροφόρησης https://library.upatras.gr/support/rights ή 
να επικοινωνήσετε με την κυρία Ευγενία Ορφανού στο eorfanou@upatras.gr.  
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Διατίθεται με άδεια Creative Commons Αναφορά Δημιουργού (CC BY 4.0 GR) 
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